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Installation & Configuration Guide

Introduction

Installation and configuration of the SmartPTT PLUS system is a complex task and comprises the following steps:
1. Installation and configuration of SmartPTT Radioserver.
2. SmartPTT Dispatcher installation and configuration.
3. Configuration of MOTOTRBO devices, e.g., radios and repeaters.
4. Configuration of MOTOTRBO tools: MOTOTRBO Network Interface Sernice Configuration Utility and
MOTOTRBO DDMS Administrative Client (for networks based on the NAI protocol).
The system configuration depends on the network used and the devices available. In this document, you will learn
how to install and configure the system on the basis of Linked Capacity Plus (LCP) and Connect Plus networks

consisting of 3 sites.

Installation of the SmartPTT software

Installation of the SmartPTT software allows making the following:
e Fresh installation of the SmartPTT software.
e Adding the programs and applications which were omitted during the previous installation.
e Repairing the errors occurred during the previous installation.

e Uninstallation of the SmartPTT software.

Note. If you wish to upgrade the SmartPTT software by means of the product or version, you should uninstall the

current SmartPTT software and then install a new one.

Before the installation make sure the following:
e You have Microsoft .NET Framework installed (not earlier than 4.6):
o YES: you will not be asked to install it.
o NO: you should agree to install Microsoft .NET Framework when InstallShield Wizard will ask you.
e You have Microsoft SQL Server installed:
o YES: specify if its version is not earlier than 2008:
= YES: select This feature will not be available for Microsoft SQL Express during the installation

of the SmartPTT software.
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= NO: you should upgrade to at least Microsoft SQL Server 2008 before the installation of the
SmartPTT software and select This feature will not be available during the installation of the
SmartPTT software.
o NO: you should select This feature will be installed on local hard drive during the installation of the

SmartPTT software.

2]

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature D ipti
- = = | SmartFTT Radioserver s

Microsoft SQL Express
=3 This feature will be installed on local hard drive. « Click any to install
=38 This feature, and all subfeatures, will be installed on local hard drive, s« Microsoft SQL Server

Microsoft SQL Express

B This feature will be installed to run from network.
ﬁ, 2 This feature, and all subfeatures, will be installed to run from the network.

=0 This feature will be installed when required.

Install to Click to unselect the
This feature will not be available. _ installation of
C:'\Progr Microsoft SQL Server

Installshield

[ Help | [ space || <Back | next> |[ cancel |

To begin the installation of the SmartPTT software:

1. Run autorun.exe file from the folder where you copied SmartPTT installation package.
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2. Choose between SmartPTT Radioserver and SmartPTT Dispatcher to install on the current PC. If you install

both of them on the same PC, we would recommend you to start with Radioserver.

-
€ SmartPTT

(=
@mdrﬂ:’TT
O

ra Ty

Click to learn about
the SmartPTT software

About SmartPTT

L.

b |
~ —~,
Click to start the
installation of SmartPTT
Dispatcher

Install SmartPTT
Dispatcher

LS.

| .
~ —~,
Click to start the
installation of SmartPTT
Radioserver

Install SmartPTT
Radioserver

-

\
J

Click to view the
information about us

Contact us

3. Follow the instructions of InstallShield Wizard. You should perform the following additional actions during the

installation:

a. Install Microsoft .NET Framework if InstallShield Wizard asks you. It is needed for the work of the

SmartPTT software.

b. Restart the PC after Microsoft .NET Framework installation if InstallShield Wizard asks you.

Note. In rare cases InstallShield Wizard will not ask you to restart the PC. However, the problem may occur in the

work of the freshly installed SmartPTT software. If you notice them, please, start the installation and select

Modify or Repair in the Program Maintenance window.
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c. Select the proper variant in the Program Maintenance window:

ﬁ SmaAare-

Program Maintenance

Maodify, repair, or remove the program.

Select to modify the installed product .
(e.g. add SmartPTT Remote Assistance) ~@ Modify

Change which program features are installed. This option displays the
-] | @ Custom Selection dialog in which you can change the way features are
Select to repair errors during the

installed.
previous installation

- Repair

Repair installation errars in the program. This option fixes missing or
"I | corrupt files, shortocuts, and registry entries.
=
Select to uninstall the =
SmartPTT software <) Remove

Remaove Sma——

InstallShield

d. Install or do not install Microsoft SQL Senver:

o if you have Microsoft SQL Server not earlier than 2008 version, in the Custom Setup window click the
Microsoft SQL Express icon and select This feature will not be available.

o if you have Microsoft SQL Server earlier than 2008 version, in the Custom Setup window click the
Microsoft SQL Express icon and select This feature will not be available. Then you should upgrade

to at least Microsoft SQL Server 2008.
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o if you do not have Microsoft SQL Server, you should select in the Custom Setup window. For this in the
Custom Setup window click the Microsoft SQL Express icon and select This feature will be installed

on local hard drive or This feature, and all subfeatures, will be installed on local hard drive.

[

Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature D ipti
s (=) v | SmartPTT Radioserver ==ir=bEr ]

Microsoft SQL Express Microsoft SQL Express
=3 Thiz feature will be installed on local hard drive, = — f_:lic:l-c Sl
=18 This feature, and all subfeatures, will be installed on local hard drive. « | Microsoft SQL Server

Bm  This feature will be installed to run from network.
_@ B This feature, and all subfeatures, will be installed to run from the network.

=0 This feature will be installed when required.

Install to

installation of
Microsoft SQL Server

This feature will not be available.

C:'\Progn
e sk

Installshield

L v [ space [

‘{ Click to unselect the ‘

General SmartPTT Radioserver Configuration

General configuration includes parameters that are independent of the network type. To configure the general

settings of the radioserver open SmartPTT Radioserver Configurator.
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1. Set up parameters of the radioserver.

:Eg

)

Example: 1-99,150

)

-
@ SmartPTT Server Configuration - C:\Program Files (xB&)\SmartPTT\Server\RadioService.exe.config
Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |
-5 Radio Server
ieigh Licenses
-4 Radio Network Services Server Role lF‘rima
'"l-a-' Add-on Modules _
ﬁ Profiles Name Radioserver
i Subscriber Groups
il Metadata Interface Port
(192.168.37.110 ~| lessz
Authentication
[No )
WolP Listen Port 18500
Block option [Hadio Disable
Limit Radios to Service
[] Enabled
Allowed Radio Numbers |
Process priority [Above nomnal
Language English

¢ In the Name field specify the radioserver name. This name is used only in SmartPTT Radioserver

Configurator;

¢ In the Interface field and the Port field specify the IP address and port of the PC where the radioserver is

installed.

2. Enable radio network senvices, e.g., ARS, GPS and TMS support.

SmartPTT PLUS 9.1
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General SmartPTT Radioserver Configuration

e To enable ARS support, select the Active check box under ARS:

p
&) SmartPTT Server Configuration - C:\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config e B e S
Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/Import Settings | Statistics |
- Radio Server ARS
@, Licenses ]
- Radio Network Services Active
..... rl ARS
Use Radio Check
""" & TM3 Radio Inactivity Timeout, s 60
----- (a Telemetry
""" ({? Subscriber Blacklist Global Minimum Request Interval, ms 1000
B~ Email Gateway
=Kl SM5 Gateway Automatic update of registration, h
----- % Fil= Receive
[j---L; Add-on Modules
ﬂ Profiles
i Subscriber Groups
[l Metadata
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e To enable GPS support, select the Active check box under GPS:

-
&) SmartPTT Server Configuration - C:\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config | B | S
Settings | Netwarks | Cliert List | Rules | Activty | Log | Export/import Settings | Statistics |
- Radio Server GPS
% Licenses _
=4 Radio Network Services Active
..... ARS
Q Minimum location update interval, s 60
----- & TMS
----- (a Telemetry Minimum Request Interval, s 1
----- » Subscrber Blacklist
E-f—] Email Gateway ) -
- SMS Gateway Radio Inactivity Timeout, s 60
----- o File Receive ] ) ]
D___L-"A Add-on Modules Get Subscriber Location for Following Groups:
-k Profiles
% Subscriber Groups Group Name Time Interval, s On/Cff
[l Metadata
Allow Dispatchers to Amend Location Update Time Interval
e To enable text messaging senvce, select the Active check box under TMS:
-
&) SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config | ) | |
Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/Import Settings | Statistics |
~F Radio Server TMS
@, Licenses _ )
B# Radio Metwork Services Active
ARS
a0 GPS
" ThS
(2 Telemetry
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SmartPTT Dispatcher Configuration

In this topic you will learn how to configure general settings of the SmartPTT Dispatcher console. The general
configuration in the scope of the LCP or Connect Plus network implies that operators will be able to communicate
with radio subscribers and the radio subscribers will be able to communicate with each other.
The general configuration of the SmartPTT Dispatcher console includes the following steps:
1. License installation
2. Database creation
3. Radiosenver configuration
4. Audio setting configuration
5. Registration of radio subscribers
The description of the steps is given below:
1. Expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and click Licenses.
Install the required license. After uploading the license, click Finish to apply.
2. Expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and click Database.
In the opened window create the new database and then connect to it.
To create a new database, fill in the Database Server Name and click Create New Database. For a database
senver installed together with the SmartPTT Dispatcher application enter the name using the format: Name of
PC\SQLExpress (for example, MYCOMP\SQLExpress).

In the window that opened enter the name of the new database and click Save.
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Database
Settings for connection to M5 SQL Server database

— Database server

Database server name | localhostSQLExpress |

For database server installed locally at SmartPTT Dispatcher PC enter name in the following way:
Name of Computer\SQLExpress (e.g.,, MYCOMP\SQLExpress).

Authorization mode [Windows NT Authorization | vl

Account name

Password

Database

Connection to the database server Is established.

[ Create database J [ Restore database J

Create Database
currg

Database name ‘ MNew Database |

| sae | [ Cancel |

Help | Cancel || Back | Nex || Finish

If creation was successful, a message about successful database creation is displayed. If the database is not
created, the reason will be displayed at the bottom of the window.

Authorization Mode — allows you to select authorization mode with the database.

SQL Server Authorization — you must have the login and password of the account which has access to the
SQL senver.

Windows NT Authorization — the user who has logged into the Windows system, must be listed in the SQL
sener’s list of users to make connection.

After you hawe finished, click Finish to save the changes. You will need to restart SmartPTT Dispatcher to apply

the changes.
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12

3. Inthe Settings menu click Radioservers to add the radioserver and configure it properly.

Radioservers

Radioservers controlled by Dispatcher Consaole

0;

4+ add / Edit

= Delets

Q, search

Server Name

| Address

Proxy

Login Active

Click Add to open the window for adding radioservers to the list.

Active

Radioserver b ¢
General

MName | Radadiossrver 1

Address | 192.168.36.110

| Port

Proxy |

| Proxy Port

B8BE8

Login |

Password |

Operator

| Profile Mame

JLLEIL

Administrator

Dispatcher

[ {none)

M

[ [none)

[~

-

OK

J |

Cancel

Enter the name of the radioserver in the Name field. The name will be displayed in the SmartPTT Dispatcher

console.
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SmartPTT Dispatcher Configuration 13

In the Address and Port fields enter the radioserver IP address and port number to connect with the dispatcher.
To find out the radioserver IP run the ipconfig command on the PC where the radioserver is installed. The
default radioserver port number is 8888.

Select the Active check box to enable the radioserver.

For more information about the radioserver settings see Help in the SmartPTT Dispatcher application.

4. Audio setting configuration is required to give the operator the ability to communicate with the radio
subscribers. Expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Sound.

Sound Settings
Audio devices and VoIP settings

General Settings | Audio Output Devices | Other Settings |

— Audio Input
Device | Default M
Input Line [ | ~|
Noise Reduction | Disabled K
AudioTnput Test | Record | | Py ||  sae |
— Audio Output
Device | Default | v ] [ Check

—WolP Parameters

Codec [CC]'IT u-Law | ']

Codec Format | 8000 Hz, 20 ms, 64 (26) kbps | ~|

VoIP Port 18501

Cancel | [ Finish

Audio Input — audio device to which the microphone is connected.
Input Line — audio mixer line used to connect a microphone.

Audio Output — audio device to which headsets or speakers are connected.
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Codec — audio stream compression method.

Bitrate — audio stream sampling frequency.

VolIP Port — audio stream receive port.

Specifications of the codec format 8000 Hz, 20 ms, 64 (86) kbps:

8000Hz — the sampling rate.
20 ms - the frame size.

64 kbps — the wice data bit rate.

86 kbps — a full bit rate (required network bandwidth).

For more information see Help in the SmartPTT Dispatcher application.

14

5. Register radio subscribers. Unregistered radio subscribers are displayed in italics in the Radio Fleet window

and are not recorded into the database.

- B Radioserver =

- ol Slot1 PTT >»
e

[ B 120022 ] { Empty ) PTT »

- ol Slot2 PTT >»

B Paul ] {Empty ) PTT »
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15

To register the radio subscriber, right-click on the radio subscriber, enter the name and click Save.

[ Select J[x]

[] Lone Worker

Properties: Subscriber 1 X
Common

= o
mMDcID | |sToned | |

Name | Subscriber 1

Status [ Busy

| ~]

Gl [¥

Default

[ o

Linked Capacity Plus

To configure Linked Capacity Plus (LCP) system consisting of 3 sites with 2 repeaters on each site, see the

following network scheme:

SmartPTT PLUS 9.1

Installation & Configuration Guide



Linked Capacity Plus

16

Site1

ID=11

ID=12

LAN Metworlk

Site 2 Site 3
Maste, ‘
ID=21 - ID=31 ~
Z :
ID=22 =z ID=32 =
= =
5 5

Router + Switch

Router+ Switch

Router+ Switch

WANM IP Network

Each radio ID, either subscriber radio ID or repeater ID should be unique in the radio system. In this example you

can see 2 repeaters with ID's 77 and 72 on Site 1, 2 repeaters with ID's 27 and 22 on Site 2, and 2 repeaters with

ID's 31 and 32 on Site 3. The repeater with ID=37 is a Master.

MOTOTRBO Equipment Programming

To program MOTOTRBO equipment you will need MOTOTRBO Customer Programming Software (CPS).

1. Connect your device to the PC via a programming cable and launch MOTOTRBO CPS.

2. Switch on the device and check its settings by clicking the Read button on the menu bar.

.
. MOTOTRBO Customer Programming

Software

| =
:AM

3%
Open Save | Reporis | Delete

Fie Edit View Device Features Hemote Help

d

Cut Copy Paste

Q
Search

(2=)os 2
Read | Wnte Clone | Bluetooth |

SmartPTT PLUS 9.1
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Linked Capacity Plus 17

3. Inthe View menu select Expert to gain access to all the setting parameters.

-
. MOTOTRBO Customer Programming Software

) £
Q[ rm e M 192168.11.1 .
Search | Read Write Clone | Bluetooth |

4. In the Device Information tab make sure that firmware version is no older than:
e R01.12.11 or R02.30.10 for mobile or portable radios;
e R02.30.12 for repeaters.

Otherwise, contact the supplier to request firmware upgrade.

Note: It is recommended to use the same or compatible firmware versions for all MOTOTRBO equipment on

the same network.

DM 3600 - . -
B ﬁ ra,m 7 Device Information

"""" R Acocessories Top  Device Features  Codeplug Memory Usage
------- EE Buttons
....... Ed Text Messages Model Number  M27QNHSAZAN
"""" @ Telemetry Tanaps Number  PMUEZ240A4
....... H wvenu
....... G Securty = Serisl Number  038THS2518
"""" = Network Firmware D D105ADD323864E539B51345507645803
& 0 F Range (MHz) 403.000000-470.000000
reguency Range z I .
B B8 Contacts
[ (B8 RX Group Lists Power Range (W) 1.0-30.0
Erh- @8 Channels Firmware Version R01.12.10
- @8 Scan
- _ Roam B Codeplug Version  13.01.03

5. To apply the changes in the settings, click Write.
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MOTOTRBO Radio Programming

1. In the General Settings specify Radio ID.

= B DP3s0 .
W General Settings General Settlngs
] tecessories Top  Wicrophone  Battery Saver  Alens  PersistentLRRP Reguests  Lone orke
-~ EdE Buttons

Fassword and Lock
oo B Text Messages -
o @0 Telemetry T IMD‘tDrDla
E henu
o Security Radio 1D EDD
-;a- Metwork: GRS ¥
- Sigraling Syaters
- Contacts Private Callz |V
G- R Group Lists Site Search Timer (zec) IH
[+ @8 Channels

Select GPS, if you need to track the subscriber location (only for radios with GPS support DP/DM 3401, 3601,
4401, 4601, DP 4801, SL4010).

Select Private Calls, if radio subscriber needs to transmit private calls. If Private Call is not selected, radio
subscriber won't be able to initiate a private call, but the user can continue to receive and respond to private calls,

and is still able to initiate call alerts.
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2. In the Network tab configure the necessary settings.

E- g DP3601
....... GeneralSe‘l‘tings NEtWDrk

------- Q Accessones Top Radio Metwork  Services  |P Site Connect
------- Buttons
_______ BA Text Messages RadiolP | 182 . 188 . 10 . 1
....... E Telemetry

Accessory IP 192 168.10.2
....... cﬂ Menu
....... = Securty Metmask 255255.285.0
------- v [T
= Signaling Systems Radio Network
- Contacts
- RX Group Lists CAl Metwork |12 3:
+-- M Channels
B - CAl Group Network IZZE 3:
- [@@ Roam Max TX POU Size (bytes) |5.|].u vI
G- 8 Capacity Plus

Telemetry UDP Port I.m.ug 3:
Forward to PC | Dizabied -

ARS Radio ID

ARSIP

-
o =
=
=
o

'
-

ARS UDF Port  |apos

TMS Radic ID |4

=
=
=
=]

TMSIP

¢ In the Forward to PC field select Disabled.

o If you plan to work with SmartPTT application specify ARS Radio ID and TMS Radio ID. Remember that
the ARS Radio ID and TMS Radio ID should match the MNIS Radio ID in the MOTOTRBO MNIS
application and Slot ID in SmartPTT Radioserver Configurator. In our case, ARS Radio ID=TMS Radio
ID=Slot ID=MNIS ID=1.
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3. In the Contacts tab right-click on the Capacity Plus system to add necessary contacts (Private Call,
Group Call, All Call) to subscriber's contact list. When configuring the Master repeater, we added 2 groups
as wide groups in the Talkgroups tab. Group 1 with ID=17 is available for all sites, Group 2 with ID=2 is
available for Site 2 and Site 3. Local groups should be added in the radio settings. In this example we will
add 4 groups: Group 1, Group 2 — as wide groups, Group 3 and Group 4 as local groups, and other

necessary contacts.

- BEW (General Settings
.. AE Buttons Contact Name Call ID Recenve | Ring Style E_T;:B?QB
.. B8 Text Messages Tone
“a reem [U-- T
- 5] Menu {s# | Groupz 2 ﬁ [T | mNostie Repetitive
i Security £ | aca 255 = ¥ | nNoste Repetitive
g Network £ | Dispatcher_Voice 1 H T Nostie Mementary
- Signaling Systems 2
El- @ Contacts g8 |70 e = P |Neste Momentary
7 @8 MOC 5 | Groups : S T Noste Repefiive
Fl- @8 QuikCall {a | Groups 4 H T [ Noste REFZILCE
(- @8 Digital £ | Dispatcher-Data 1 = T |Noste Repetitve
= W Capacity Plus
Giﬁ Groupl
cgﬁ Group2
{2 Dispatcher_Vaice
{1 § 70
------cgﬁ Group3
Giﬁ Groupd
W% Dispatcher-Data
El- 48 Phene

Also, add Dispatcher Call for transmitting data to SmartPTT Radioserver and PC Call to be able to initiate calls
to SmartPTT Dispatcher. Make sure that the IDs of these calls equal Slot ID in SmartPTT Radioserver

Configurator (see SmartPTT Radioserver Configurator).
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4. Add these groups to the RX List. In our example we use the same RXlist for all sites. That is why the RX

List contains all the groups.

DP 3601 .
E E ...... Seneral S'Eﬂil'lgs LCPVD |Ce

....... Q ACCESSones

....... Buttons fusiable Members

------- E Text Messages Groupt

------- I Telemetry Group2

------- cﬁ Men Group3
Groupd

....... & Security - Add

....... 'ﬁiﬁ' Network

B Signaling Systems =< Remove

Bl &8 RX Group Lists

Zone
- M Channe! Pool

5. Add all repeaters, which are in the LCP system, to the Channel Pool. The color code should equal the color
code specified for repeaters. In our case Color Code=1. Define the RX and TX frequencies. They must
correspond to the frequencies set in the repeater, but RX of the radio must correspond to TX of the repeater

and TX of the radio must correspond to RX of the repeater.

= [ ©DP3s01
------- General Settings

LCPSite3-31

....... Q Accezsones Top RX TX

------- Buttons

------- B TextMessages Color Code H

------- @D Telemetry

....... CH Menu Phone System INDnB .l
....... F Security

------- & I

G- [ Signaing Systems

[ Contacts Offset (MHz)

- RX Group Lists W

=} @8 Channels Frequency (MHz) [162.075000 : Frequency (MHz) |167.800000
Zonel Copy |
= Pl Channel Pool

L) | CPSitet-11 Ref Frequency (MHz) IDEFath 'l Ref Frequency (MHz) IDBfath 'I
@0 LePstet-12
@1 | cpsite-21
@ | cPsite2-22
-~
L) LCPSte3-32
TS Zonc?
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6. Create Voice lists and Data lists according to the amount of sites. As all of our repeaters are Trunk
repeaters (transmit wice and data), create only Voice lists. When adding new Voice list, under the
Available list you can see all the channels which were added to the Channel Pool. So, for Site 1 add a

Voice list (LCP Site 1) and add LCP Site 1-11 and LCP Site 1-12 to this list.

S e LCP Site1

------- @ ACCESSONES
....... Buttons Ay ailable Members D5

------- B Text Messages LCPSite2-21 LCPSite1-11 12
....... @ Telemetry LCPSite2-22 LCPSited-12 34

LCPSite3-31 65
T menu LCPSite3-32 7.8

! 9-10
------- 2 Network —_— 1112

- @8 Signaling Systems
RX Group Lists
H-- Channels

- Secan

- Roam

..... BAE] | CF sitet

b WS CP Site2

(L

b |]n:? LCF Site3

Data

e O o O o O oy O sy Y e
[

Please note that IDs in the Members list should correspond to Slot 1 ID Channel and Slot 2 ID Channel
specified in repeater settings.

7. Create Voice lists for Site 2 and Site 3 accordingly.

SmartPTT PLUS 9.1 Installation & Configuration Guide



Linked Capacity Plus

8. Configure Sites lists. If you do not use roaming, create several site lists and add only one site per list.

Since in this example there are three Sites, add three Sites lists.

§ DP 3801

O g o o Y |

....... Generﬂ .SEtﬁngs
------- & Accessories

....... Buﬁons

....... Ed Text Messages
------- @5 Telemetry

....... CH Menu

H-- [@ Signaling Systems
- @ Contacts

- RX Group Lists
Fl-- Channels

- Secan

- Roam

El- @ Capaciy Plus

G- @ Voics

Data

B

-, B LCP Ste2
il B LCP Site3

For each Site configure:

23

LCP Site1

RSE| Threshold (dBm) |_1ua 3;

Aaid | Delete |
Site: |ID Site Alias Voice List Data List RX Group List
[ Site1 LCP Sited Mone LCPVoice

e Site ID — ID of the site to which the subscriber radio is connected.

Site Alias — name of the site to which the subscriber radio is connected.

Data List — Data Channel List which the subscriber radio will use to make data calls when on the site.

Voice List — Voice Channel List which the subscriber radio will use to make woice calls when on the site.

RX Group List — RX Group List which the subscriber radio will use to receive group calls when on the site.
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If subscriber roams between different sites, one site list will contain several sites.

In our case a subscriber with Radio ID=700 can roam between all three sites, so we created one Sites list with

all the sites.

B~ § or3sm .
@8 General Seffings LCP Sites

. @F Buttons RSSI Threshold (dBm)  |_qpg

Add
- [ Telemetry

':H Menu

4 Site1 LCP Site1 None LCPVgice
ﬁr"a- Network

- B Text Messages | Deit |
Delete

Site 1D |S‘iteﬁias Woice List Data List RX Group List

@8 Sgnaing Systems 2 -] ste2 LCP Site? None LCPVoice
. (@@ Contacts 3 =] sitea LCF Site? None LCPVoice
- RX Group Lists
- Channels

- Scan

. B8 Roam

- @8 Capacity Plus

Waoice

Data

NP RE] L CP sites

LS Iy 6

mmmmmmm

SmartPTT PLUS 9.1 Installation & Configuration Guide



Linked Capacity Plus 25
9. Add LCP Personalities. To do this, right-click on Zone and add Capacity Plus Personality (linked).

=~ § DP3sot )
....... cenerst setings LCP Site1

....... Q Accessories Top RX T
------- Buttons

ARS | On systenvSte Change v |

Privacy [~
Privacy Alias I Privacy Key - l
RAS Aias |NDne j
Option Board [~

Lone Worker |

Messaging Delay (ms) Isﬂ 3:

Compressed UDP Data Header [

Auto Roam W

Site List ILCP Sites vl

Rest Channel Acquisition TOT (min) |5 3:
Beacon Interval (ms) Imzn 3:
r

RX Only

R
Emergency Alarm Indication W Contact Name IGroup1 'l

Emergency Alarm Ack r Emergency System Sys1 -
Emergency Call Indication W vox |
Power Level || gw

TOT (sec)

TOT Rekey Delay (sec)

Allew Interruption

1133

TX Interruptible Freguencies

Agimit Criteria |Chﬁnm| Free j

In Call Criteria TX Interrupt -
RSSI Threshold (dBm) |_gu 3:

Private Call Confirmed  [v
r

Data Call Confirmed

For each channel specify:
o ARS - select On System/Site Change. ARS feature provides an automatic radio registration. When the

radio powers up, the radio automatically registers with the server. This feature is also used with Text

Messaging or Location Services.
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Auto Roam — select Auto Roam if the radio is to roam between sites in the LCP system. If disabled, the

radio subscriber won’t be able to roam to another LCP site when moving from one site to another.

For each channel select appropriate Sites list. The subscriber radio can roam to the sites listed in the

Sites list.

Select Contact Name which defines the call that may be initiated on the channel by pressing the PTT

button, when there are no active calls on the channel.

Select Private Call Confirmed and clear Data Call Confirmed.

MNIS and DDMS Client Configuration

In order to process data packets, ARS, Call Alerts, GPS, TMS, it is obligatory to have MOTOTRBO Network
Interface Senice Configuration Utility (MNIS) and MOTOTRBO DDMS Administrative Client properly installed and

configured.

Let's start with MOTOTRBO Network Interface Senice Configuration Utility (MNIS).

Note: Before configuring, make sure the firmware versions of the repeaters and MOTOTRBO Network Interface

Senvice are compatible (please find compatibility information in MNIS Release Notes).

1. In the General section in the System Operation Mode field select network type. In our case, it is Linked

Capacity Plus.

MOTOTRBO Network Interface Service Configuration Utility |:|

&

Configuration  Yiew  Edit  Service  Help

) H O Ol@

= a1
: General

General

o Securit .

L }I_ System Operation Mode | Linked Capacity Plus
= &8 Group List

8B st MNIS Application 1D [ 3
= @8 Conventional

I DA meeeoiod
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In the Linked Capacity Plus section set up Master IP Address and Master UDP Port fields. These values

should correspond to the same values in MOTOTRBO CPS and in SmartPTT Radioserver Configurator, which

you will set up later.

Configuration  Wiew  Edit  Service

Oy H S

o @ 11

General

@ Securty

& Grouplis
0B Listt

5. @ Corventionsl

% Capaciy Plus

5 8 Advanced
2 Netwok
Ep Forwarding Rules
application Dver

MOTOTRBO Network Interface Service Configuratio;

Help

(=3K>)

Linked Capacity Plus

Master IP Address | 10.150.0.20

Master UDF Port 50000 E

MNIS LE ot 8 Automaticaly Assigned
© Manualy Assigned

Mone

SmartPTT PLUS 9.1

Privearn Setinn Mrma -
Settings
= B Risdio Server NAI Network
& Radio Network Services
) kb Hodkdes Active
% Cortrol Stations
Ionnect Flus Name [MNAI Network 1
Fadio Activiy Netwoiks )
= i NAI Networks
= MAl Netnak Peat I
1 st =
=7 ,'DG Interface [1921680158 | Pon [50001 3]
oups
B MNIS/DDMS Settings Waster Fiepealer AJSIEss (10 120.0.20,50000 =
hostport]
Authetication Key ‘

@8 Talkgroups
& Channels

Top Radio Network Link Establishment IP Site Connect Capacity Plus Pl
Radio IP 192 . 168 . 10 . 1

Accessory [P 192.168.10.2

Netmask 255255 2660

Radio Network

CalNetaork [12 =]
CAl Group Network [z25 =]

Link Establishmen
Link Type | Master -

Puthentication Key

Mester P [ 10 150 0 20
Master UDP Port lm
oHce [T
EthemetiP [ 10 . 180 . 0 . 20
Gateway® [ 10 . 10 . 0 . 1

Gateway Netmask 265 . 266 . 266 . 0
UDP Port  |5p000 3:
Peer Firewall Open Timer (sec) |g 3:

Master Archive File
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3. It is recommended to clear the Data Call Confirmed field in the Advanced section and to specify the
identifier in the MNIS LE ID field explicitly. Make sure MNIS LE ID does not match Peer ID of any repeaters

in the system.

MOTOTRBO Network Interface Service Configuration Utility *

Configuration  Wiew  Edit Service  Help
General

i Securty
= @8 GroupList Data Call Confimed [
'3& Listl Compressed UDP Data Header |
= &8 Carventional
E- =B Domain 1 Battery Saver Preamble

:EE Domain 2 Individual D ata to Registered Site [
eﬂ- Capacity Plus
= @ Linked Capacity Plus T Preamble Duration [ms] 120
Sites
=2 ﬁ Advanced Conventional Channel Access 0
ﬁ- Metwork,

= Forwarding Rules
&pplication Oweride Rules MMIS LE 1D ) Use MNIS D

(& Manually Assigned 3 =

Note: In the Firewall settings add MNIS into the exception list.

DDMS operation is closely connected to MNIS for data exchange (MNIS serves as DDMS Watcher). DDMS filters
ARS packets, received by the repeater, and information on the radio presence in the network is sent to all

systems for further processing.
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Therefore, when you configure DDMS settings, make sure that:
1. The PortWatcher field in MOTOTRBO DDMS Administrative Client matches the WatcherPort field in MNIS

settings (Advanced > Network).

e Configuration Utility

Configuration Service File  Action Help

::ﬁ l I ° @ 000 Elm‘i? HE %
L . % Service Bl Watcher Settings
S e s 4 [ [ =] Inter; PortWatch: 3000
@ Unttled = = ool :I:sessmings 'at! er! ‘”I'I

View  Edit Help

o

. General ARS Moritor ; & NotfyGroup o
G Secutty ARS Morior D +if Logdng NotfyFate 5
&) Group List
&4 Conventional PortWatcher
§#: Capacty Plus Por g:Tbr'\fD for ViicherSubscrberequesi
<09 Linked Capaciy Plus Server Address  127.0.0.1
B & Advanced Settings for Watcher interface
o el

[ Forwarding Rules

2. The PORT SU field (Interfaces > ARS Settings) in MOTOTRBO DDMS Administrative Client matches the

ARS UDP Port field in MOTOTRBO Network Interface Senvice Configuration Utility (Advanced > Networks).

MOTOTRBO Network Interfac
File  Action Help

G]@ O @& @ %

|| [ 58 Servics EI_ARS Seltings
. Interfaces PortSU 4005
| Passvelods Wi

Configuration  View Edit  Service Help

B L HO (7]

= @ Untitled

General =@ Watcher Settings DeviceRefreshTime 240
i @ Secuity CAl Network |12 E‘ Logging Deregistration TO 120
. Persistence TO 12000
# Group List

& Conventional CAl Group Network 225 |
- Capacity Plus
< Linked Capacity Plu:

PortSU
Port listening forinbound ARS messages
Range: 1000 - 65535

5 @ Advanced Settings for ARS/SU interface
; ARS UDP Port (4005
e o
i+ I Forwarding Rule TMSUDP Pt [4007 2

Application Ove

SmartPTT PLUS 9.1 Installation & Configuration Guide



Linked Capacity Plus

SmartPTT Radioserver Configuration

30

1. Run SmartPTT Radioserver Configurator, which you have downloaded and installed, as described in

SmartPTT Software Installation.

2. In the setting tree on the left, right-click on NAI Systems, point to Add and click NAI - Linked Capacity

Plus.

3. In the opened window specify the following settings of the LCP network:

-
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService exe.config

mlﬁlg

Settings | Networks | Client List | Network Configuration | Rules | Activity | Log

I Export/Import Settings I Statistic5|

- Cortrol Stations

[y Connect Plus

BH MNAI Systems
B Cikced Capacty Plus |
E| T_ Slat 1
'T_ Sites

&k Talkgroups

LT Securty Settings

-y Capacity Max Networks
g SIP/RTP Interfaces
--E8 SmartPTT Radioservers

¢ Name — add network name.

HAI - Linked Capacity Plus Hetwork

Active

Mame MNAI- Linked Capacity Flus 1
Metwaork [D 5

Peer ID 1

Master repeater address )
(IP Address Port) 10.150.0.20:50000

Authentication key

Voice transmission [Hapeaters

Group call hang time, ms
Private call hang time, ms

Max number of telephone calls
Diata transmission
Manitoring

0002 =
Test
3000 =
4000 =
100 =

o Network ID — specify unique ID of the network. The network ID must not match any ID of the other

SmartPTT Radioserver networks.

e Peer ID — enter unique ID of the virtual repeater in the network. The virtual repeater ID must not match any

of the other repeater IDs in this network.

o Interface — specify the IP address of the PC where SmartPTT Radioserver is installed.

e Port — set up port number of SmartPTT Radiosenver. It should differ from the corresponding ports in other

networks.
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Master repeater address (host:port) — specify IP address and port number of the Master repeater (see

Master IP and Master UDP Port in MOTOTRBO CPS). In this example it is 70.750.0.20:50000.

Click Test to check connection between the virtual and Master repeaters.

Authentication Key — enter repeater authorization key (to be equal to the Authentication Key in the

repeater settings in MOTOTRBO CPS). In this example we are not setting any authentication keys.

Voice transmission can be carried out in two ways: via repeaters and via control stations. To transmit
woice via control stations, configure control station parameters and profiles for making private calls. To
transmit voice via repeaters, configure virtual control station channels and talkgroups of the channel. The
number of channels depends on the network type. To ensure data packets transmission over the network,
configure the DDMS and MNIS senices. To transmit CSBK commands use control stations for woice
transfer. To transmit data and monitoring data select the corresponding check boxes (Data transmission
and Monitoring). If Data transmission is not selected, all data packets will be gray and no data type
differentiation will be applied in the Monitoring panel in SmartPTT Dispatcher. If Data transmission is
selected, the data packets addressed to you will be defined, and other data packets, not addressed to

you, will be gray.
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4. Configure slot parameters. In order to do that, go to Slot 1 in the setting tree of SmartPTT Radioserver
Configurator.
,
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@Q
Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Bxport/Import Settings | Statistics |
E Control Stations HAI Control Station
[+-myg Connect Plus )
-l NAI Systems Active
=g MAI- Linked Capacity Flus 1
o .1 Name  Slot 1
] Stes Radio ID 1 :
Talkgroups 1o z
¢ gt Security Settings CAl Network 12 =
-l DDMS Settings
L. MNIS Data Gateway CAl Network for Groups | 225 =

[j--g’ Capacity Max Networks
[j--H’ SIP/RTP Intedfaces
- E9 SmartPTT Radioservers TX Time-Out Timer, s |60

[T] AMllow Telephone Interconnect

4 F

Cptions
[] Emergency alam confimed

[T Allow transmit intemupt

GPS Transmission Mode | Data -

Confirmed Events
Private calls

o Name — specify the name of the slot.

e Radio ID — set unique ID of a virtual control station corresponding to the network slot. Remember that it
should match ARS Radio ID, TMS Radio ID and MNIS ID, in this example it is 1.

e CAIl Network — CAl-network ID. Use the default value of 12 (must match MOTOTRBO CPS settings).

o CAIl Network for Groups — CAl-network for groups ID. Use the default value of 225 (must match CAl
Group Network in MOTOTRBO CPS settings).

o Emergency Alarm Confirmed — select this check box if you need the emergency alarm be
acknowledged.

o Private Calls — select this check box if you need set private calls on the current digital channel as
confirmed.

o Allow Transmit Interrupt — select this check box if you need the ability to interrupt a radio subscriber.

¢ GPS Transmission Mode — allows you to select the way how to transmit location updates: as a data

packet in multiple bursts or as a single CSBK (Control Signaling Block). This time select Data.

32
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o Allow Telephone Interconnect — select this check box if you need the ability to make telephone calls

on the slot.

5. Configure talkgroup parameters. To do that, click Talkgroups. Parameters of wide area and local groups are

set in the Control Station Talkgroups window. In order to display wide area talkgroups by the SmartPTT

Dispatcher application, add necessary talkgroups in SmartPTT Radioserver Configurator, define group

identifiers which correspond to the identifiers of the wide area groups in the repeater MOTOTRBO CPS

settings and select Wide in the Site Number field. In this example we have two wide area talkgroups and

two local talkgroups, so we add them into SmartPTT Radioserver Configurator.

.
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g

Settings | Networks |C1iar|1 List | Metwork Configuration | Rules Ik:tmty | Log I Expont/Import Settings I Statistic5|

-4 Control Stations

-y Connect Plus

Ch-ig NAI Systems

/-y MAI- Linked Capacity Plus 1
D4 Slot 1

1" Sttes

Talkgroups

-y Capacity Max Networks
[]--H SIP/RTP Irtefaces
B SmartPTT Radioservers

Control Station Talkgroups

[ Copy Paste
( Al Call
[ Add ] [ Remove ] [ @ Up ¥ Down

Mame ID Site Mumber
Group 1 1 Wide -
Group 2 2 Wide -
Group 3 - Site 2 3 2 -
Group 4 - Site 2 4 2 -

Talkgroups not specified in the repeater settings are regarded as local groups. Local group call does not go

beyond the site on which the call was initiated.

To add local talkgroups, just add them in SmartPTT Radioserver Configurator, define their identifiers and select

site number from the list in the Site Number field.

Note: Wide area and local talkgroup identifiers must differ.
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6. Configure MNIS Data Gateway and DDMS settings for data transmission under MNIS Data Gateway and

DDMS Settings.

-
ﬁ SmartPTT Server Configuration - C\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config E‘Elg
Seitings | Metworks |Client List I Network Configuration I Rules I Activity | Log I Export/Import Settings | Sta’r.isticsl
:--§ Control Stationis MHIS Data Gateway
w Connect Plus
S NAI Systems Socket Type |Local Socket ~|
= NAR- Linked Capacty Plus 1 Interface (192.168.37.110 -
= ‘[ Slot 1
4" Sites MNIS Cortrol Interface loopback 55000
Talkgroups <
% Securty Settings MNIS 1D 1 IZI
&, DDMS Seftings Location Port 4001 B
g — 9 MNIS Data Gateway
[]--w Capacity Max Netwaorks TMS Port 4007 Iil
[j—-g SIF/RTF Inteffaces ‘
----- B9 SmartPTT Radioservers Telemetry Port 4008 IEI
-
@] SmartPTT Server Configuration - C\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config E‘Elg

Settings | Metworks |C]ier1t List I Netwar: Configuration I Fules I Activity | Log I Export/Import Settings | Statisticsl

-2k, Control Stations

w Connect Plus

Sy NAI Systems

=g MNAI- Linked Capacity Plus 1
E|"'L1 Slat 1

----‘11‘” Sites

& Talkgroups

4  Securty Settings

- 4 DDMS Settings

-l MNIS Data Gateway

[]--w Capacity Max Networks

[j—-w SIF/RTF Inteffaces

----- F9 SmartPTT Radioservers

SmartPTT PLUS 9.1

DOMS Settings
Active

Server Address  localhost 3000
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1) Under MNIS Data Gateway select Local Socket in the Socket Type field since the MOTOTRBO
Network Interface Senvice Configuration Utility application is installed on the same PC as SmartPTT
Radioserver.

2) MNIS Control Interface — use localhost, if MOTOTRBO Network Interface Senice is installed on the
same PC as the radioserver. If MOTOTRBO Network Interface Senice and the radioserver are installed on
different PCs, use the interface specified in the MNIS Relay Address field. The port should match the
port number specified in the MNIS Control Interface TCP Port fieldin MOTOTRBO Network Interface

Senice Configuration Utility settings:

MOTOTRBO Network Interface Service Configuration Utility

Configuration  Miew  Edit  Service  Help
= 11 ARS Monitar ID - |Mone ~
------- General
------- &= Securiy Device Discovery and Mohility Service
[+ 488 Group List
- {88 Conventional Server Address |12?.EI.EI.'I |
------ eﬂ Capacity Plus
E}----::{I'{- Linked Capacity Plus Watcher Port | 3000 ¥
= 88 Advanced
MNIS Control Interface
MMIS Control Interface TCF Portt | 55000 E
]
< I | E]

3) In the Interface field select the IP address of the PC where MOTOTRBO Network Interface Service is

installed. It must match the IP address specified in the Tunnel IP Address field of MOTOTRBO Network

Interface Senice Configuration Utility.
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4) In the MNIS ID field set up the Common Air Interface (CAl) ID of the MNIS in the radio network. The ID is
used by other calling radios when addressing MOTOTRBO Network Interface Senice. Make sure MNIS
ID matches the MNIS Application ID field in the General tab in MOTOTRBO Network Interface Senvice

Configuration Utility. It is also recommended that MNIS ID should match Radio ID in the radioserver slot

settings.
MNIS z z : e
MOTOTRBO Network Interface Service Configuration Utility
Socket Type | Local Socket w |
Configuration  Wiew  Edit  Service  Help
MnisContiol Interface |Incalhost:5000 | 3

pH 0O ®

Interface 192168.50.2 1 v [ \j

—

MNIS 1D [1 [2]2 = @ General

; General
Location Port 400 3 ’ .

Secuity Syztem Operation Mode | Linked C. ty Pl eV
inked Capacity Plus

TS Part 4007 3 = 8 Group List pacty

o 8B L 2 I MNIS Application 1D [1 - I
Telemetry Port 4008 v ¥ i =

B @8 Corvertional

=2 Domain 1
Capacity Plus Tunnel Network

Linked Capacily Plus

- B Sies MMIS IP &ddress  [192 168,501
. Advanced 1 |Tunne| IP Address 192.168.50.2 |
EEE Network

- [ Forwarding Rules Subnet Mask  255.255.255.0

[ Application Dwverride Rules

5) Inthe TMS Port, Telemetry Port and Location Port fields specify ports where the radioserver will
expect text messages, telemetry and GPS data. The ports should match the ports set in the TMS UDP
PORT, Telemetry UDP Port, Location Server UDP Port fields in MOTOTRBO Network Interface
Senice Configuration Utility (Advanced > Network).

6) Under DDMS settings specify Server Address, i.e., IP address of the PC with the MOTOTRBO DDMS
Administrative Client application installed, and port number of the DDMS server. In this case the DDMS
server is installed on the same PC as the radioserver. The port number in this field must match the port

number in the PortWatcher field of the MOTOTRBO DDMS Administrative Client (Interfaces > Watcher

Settings).
i "
£, MOTOTRBO DDMS =
DDMS File Aciion Help
Server Address 192168 37.13f3000

00 [¢)& HE %

Service
=N Interfaces
. -pf¥ ARS Settings

E Watcher Setti
I PortWatcher 3000 |
atcher [0 1

NotifyGroup 0
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Al
7. Save changes by clicking Save . To cancel the changes made, click the Restore button ﬂ . All

the changes, made after the last save, will be restored.To apply the saved changes you must restart the

senice. The senice is managed using the following buttons: Start @ Stop and Restart @ .

Capacity Max

Capacity Max is a trunking MOTOTRBO system that supports the European Telecommunications Standards
Institute (ETSI) Digital Mobile Radio (DMR) Tier Il operation.

Capacity Max system represents the enhancement of the Linked Capacity Plus functionality. It can include up to
15 sites and up to 15 trunked repeaters with up to 3,000 users per site. One slot on each site is allocated as a
control channel. Capacity Max also supports data revert repeaters: up to 6 per site and 12 time channels per site.
Capacity Max system supports connection via control stations. The parameters of the control station correspond
to the parameters of an ordinary MOTOTRBO control station.

Capacity Max systems offer the following advantages:

e The simple and efficient system architecture that utilizes standard Internet protocol (IP) network with a

centralized Capacity Max System Serer (CMSS).

£y, WNis Data IP Network
1} Gateway

SmartPTT ESX Server
Radioserver Capacity Max System Server

NIS VRG] | Trunking
Gateway | | Controller

IP Network

i

SmartPTT SmartPTT SmartPTT
Dispatcher Dispatcher Dispatcher
Console Console Console

CMSS represents the VMware Sphere version 5.5 ESX server and includes the following virtual resources:
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o Trunking Controller based on the Red Hat Linux,
o MNIS VRC gateway, and
o Radio Management application that is used instead of MOTOTRBO Customer Programming Software
(CPS) to configure the system.
The system architecture also includes the MNIS Data gatewaty, which is installed separately.
e High security. All voice, data and control traffic within the IP network is encrypted, and all radios are securely
authenticated.
o High level of reliability and resilience. The system can include an optional redundant server in addition to the
main server and up to three alternate control channels per site.
Capacity Max is compatible with all MOTOTRBO repeaters, except DR3000 series with the 8MB RAM, and all
MOTOTRBO 4000 series portable and/or mobile radio stations.
To configure the Capacity Max system in SmartPTT Radioserver Configurator, you will need to use the following
applications:
¢ Radio Management application—to get the settings of the preconfigured virtual resources, and
¢ MOTOTRBO Network Interface Senice Configuration Utility—to set up the MNIS Data gateway.
Capacity Max configuration in SmartPTT Radioserver Configurator includes the following steps:
1. Adding new network and its basic configuration.
2. Setting up the trunking controller.
3. Setting up MNIS Data gateway settings for data transfer.
4. Setting up the MNIS VRC gateway and the talkgroups.

5. Setting up the security settings.
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How to Configure Capacity Max

To add a new Capacity Max system, right-click Capacity Max Networks in the Networks tab of SmartPTT

Radioserver Configurator and click Add.

At that, Capacity Max System configuration menu appears on the right.

-2 Cortrol Stations

-y Connect Plus

g NAI Systems

EI"H Capacity Max Metworks

[ Capac:it)r Max 1

Trunking Controller
- MNIS Data Gateway
gh MNIS VRC Gateways
h MNIS VRC Gateway 1
. Talkgroups
[ Securty Settings
-y SIP/RTP Interfaces
- B0 SmartPTT Radioservers

Name: Name of the created system.

Network ID: Unique ID of the network. The network ID must not match any ID of other SmartPTT Radioserver

networks.

SmartPTT PLUS 9.1

Capacity Max System

Active

Name: Capacity Max 1

Networl [D: 1

Radio ID: 1

Interface: [An]r -

Presence information

Data transmission

Voice transmission

[T Alow transmit intemupt

[7] Prioritize calls during emergency

Channel Grant Waiting timer (s): 15
T time-out timer (s): 60

Rl L

GP5 transmission mode: [Data
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Radio ID: The identifier of the radioserver. This is the identifier radio subscribers will see at receiving private calls

and text messages from the dispatcher. If there are several dispatchers, you can create a profile for each operator

(Profiles) and define a unique identifier for each operator. Radio ID set in this window must correspond to the

value set in the Device ID field for the preconfigured radioserver device in the Radio Management application (see

the Capacity Max Systems settings, sorted by the Subscriber Access Control value).

E Radio Managernent

o]0

Capacity Max System Server Data » Subscriber Access..

Capacity Max Systems

CurSysteml
QurSysteml
QurSysteml
OurSysteml

Analyze Results|  [Tasks|
Connected To:LOCALHOST

Wiew by IEI Subscriber Access Contral I:I Talkgroup Site Association

(= o=

LRy

-+ [

\d

Device Type =~ | Serial Number Physical Serial Numb Device ID En
Console 0 4 605
Console a a 604
Console [ [4 600
Cansaole a a 603
Console a a 601
Console 0 [ 602
Data Gateway a a 300
Motorola Radio  871TNVISZS 1EQ408B45C 765584329, 102 =

1 I

9 items found (0 currently selected).

Note: To open the Capacity Max System settings in the Radio Management application, click Actions >

Manage > Capacity Max System Server Data or press the Ctrl+Shift+G together.

Interface: The IP address of the PC where SmartPTT Radioserver is installed.

Presence information: Select this check box to enable connection with Trunking Controller.

Data transmission: Select this check box to work with MNIS Data Gateway.

Voice transmission: Select this check box to enable MNIS VRC Gateway.

Allow transmit interrupt: Select this check box if you need the ability to interrupt a radio subscriber.
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Prioritize calls during emergency: Sets a priority of the dispatcher call during the Emergency Call. If the check
box is selected, the dispatcher call has the highest priority during the Emergency Call in relation to other calls
and interrupts them in case of lack of resources.

Channel Grant Waiting timer (s): Time period in seconds during which the caller expects a response from the
called party (the FOACSU strategy). It is recommended to use the default value of 15 seconds that is set in the
Radio Management application (see the Capacity Max Systems.... settings in the Capacity Max Features

menu of the Primary_CMSS_config configuration, the Channel Grant Waiting timer field in the Timers tab).

ERadin Managerment EI

kI

Configuration View » Primary CMS5_config » Capacity Max Systems » OurSysteml

Set Categories 1
Save As Close
- '@' Configuration: Primary_CMS5_config
v T Capacity Max Features General  Authentication  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement
[ El Capacity Max Systems: CapacityMaxSystems
El Capacity Max Site Selection: CapacityMaxSys ~) Timers =

(7] €MSS Network: Network-1

Channel Grant Waiting timer (sec) | 1 I
» [l VNS ]

Response Waiting timer (sec) | 2.0
Group Call Hang Time (sec) | 3 I
Private Call Hang Time (sec) | 4

Emergency Call Hang Time (sec) | 4

Inter-Repeater Messaging Delay | Mormal

Inactivity Check Timer (hour) | 0.5

. . -
P e W lmne Citne
1 — 4

4

»

Analyze Resn.lhs| Tasks |\|"a|idation Results REEtythl R U BT B Search Results |Help

Connected To:LOCALHOST

Radio Count:1

Note: To open the Capacity Max Features of the Primary_CMSS_config configuration in the Radio
Management application, click Actions > Manage > Configurations or press Alt+C together. In the table that
opened, select the Primary_CMSS_config item and click Edit. In the Set Categories tab that opened, click

Configuration: Primary_CMSS_config > Capacity Max Features.

FOACSU (Full Off Air Call Set Up) stands for the strategy of assigning the traffic channel only when the called

party user has specifically answered the call. During the timeout the traffic channel is not allocated for the call.
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For correct work of the FOACSU private calls, make sure that it is configured in the Radio Management
application (see the Capacity Max Systems:... settings in the Capacity Max Features menu of the

Primary_CMSS_config configuration, the Individual Voice Call Type field in the General tab).

Radio Management E@

L

Configuration View * Primary_CM55_config » Capacity Max Systems » OurSysteml

Set Categories s
Save As Close
4 E Configuration: Primary_CMS5_config
v T Capacity Max Features General  Authentication  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement
l El Capacity Max Systems: CapacityMaxSystems
El Capacity Max Site Selection: CapacityMaxSys ~ General i
{7] €MSS Network: Network-1 - ———
System Mame |OurSystem
» Il MNIS —]
System Type | Capacity M
Metwork Model | Large

NetworkD |1
| indivicual Voice Call Type  |FoACSU |

Call Queue Enable [

Max Infrastructure Voice Interrupt Attempts | 3

Mazx Preemption Interrupt Attempts | 6 =
1 —— 4
4 »
Analyze Resultf.| Tasks |Validation Results RRETT N RESELTSTi il Search Results |Help
Connected To:LOCALHOST Radio Countl
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TX time-out timer (s): Time period during which the radio can transmit without interruptions. After this time is

over, the transmission is interrupted. It is recommended to use the default value of 60 seconds, which is set in the

Radio Management application (see the MNIS System settings i

configuration, the Transmission TOT field in the General tab).

n the MNIS menu of the Primary_CMSS_config

E Radio Manhagement

G ]O

Configuration View ® Primary CMSS_config ® MNIS Systern » MNISSystem-

= [Fo] =]

1

Set Categories a

h E Configuration: Primary_CMS5_config
» Il Capacity Max Features
T MNIS
[ (7] MnIs System: MNISSystem-1 3t |
[l MNIS Network: MMISNetwork-1

~) General

Close
General
Set Name | MNISSystem-1 |

Last Modified Date  03/01/2016 141643

Comments | |

VRC Gateway Enable ||
MMIS Gateway UDP Port | 50000

4

»

Connected To:LOCALHOST

|

[<[+][<]

Transmission TOT (sec) | a0

Active Voice Talkpath Limit | 100

Analyze Results|  |Tasks| |Validation Results Waming [NE=L =i R Search Results | Help

<[]

Radio Count:1

Note: To open the MNIS menu of the Primary_CMSS_config configuration in the Radio Management application,

click Actions > Manage > Configurations or press Alt+C together. In the table that opened, select the

Primary_CMSS_config item and click Edit. In the Set Categori
Primary_CMSS_config > MNIS.

es tab that opened, click Configuration:

GPS Transmission Mode: Allows you to select the way how to transmit location updates: as data packet in

multiple bursts or as a single CSBK (Control Signaling Block).

Each solution has its own advantages and disadvantages:

GPS Advantages

Transmission

Mode

Data ¢ No need to configure additional settings for
receiving GPS data

CSBK e Low traffic load on a channel

SmartPTT PLUS 9.1

Disadvantages
°

Increased traffic load on a channel

¢ Not all radios support CSBK commands
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e Increased GPS transmission frequency

rate—once in 15 seconds

Enhanced e Low traffic load on a channel e Not all radios support CSBK commands
CSBK e Increased GPS transmission frequency

rate—once in 7.5 seconds

Trunking Controller

Trunking controller of the Capacity Max network provides the actual information about the network status
(registered subscribers).
To configure primary trunking controller:
1. Make sure that trunking controller is configured via the Radio Management program, in particular, you can
obtain IP address and port from the Presence Server IP field. For their configuration, please refer to the

Motorola Radio Management User Guide.

[ oo Management o=

L

Configuration View » CMS5_config » CMSS Network P CMSSNetwork-1*

Set Categories a
Save Discard Close
A E Configuration: CMSS_config

v W Capacity Max Features General
@ Capacity Max Systems: TVZCapacityMaxSystems-1

@ Capacity Max Site Selection: CMSSSiteSelection-1 Set Name |.CMSSNetwork—l |
[ (] CMSS Network: CMSSNetwork-1% £t | _
Last Modified Date  07/21/2018 16:32:10
» Il NS .
Comments | |
~) General
CMsSIP | 1920
CMSS UDP Port |5
Trunking Controlier {P

Fresence Server [P Iggﬂzl-ﬁmij

VRC Gateway IP
S N2024

3. In your Capacity Max network select Presence information to make trunking controller settings available.

2. Add a new Capacity Max network or select the existing one.
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-
'@ SmartPTT Server Configuration - C\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config

Settings | Metworks |C1ient List I Rules | Activity | Log I Export/Import Settings I Statisticsl

ﬂ Connect Plus
-y MNAI Systems
[—jg Capacity Max Networks
Bh- Capacity Max 1
Trunking Controller
B8, MNIS Data Gateway
h- MMIS VRC Gateways
----- Talkgroups
LT Security Settings
g SIP/RTF Interfaces
----- B9 SmartPTT Radioservers

Capacity Max System

Active

Mame: Capacity Max 1

Metwar 1D: 1

Radio 1D: 1

Interface: [.th -

( Presence information

Data transmission

Voice transmission

4. Select the Trunking Controller menu and replace the default text “remotehost:50015” in the Primary

controller (IP address:Port) field with IP address and port of the Presence Server from Radio Management.

-
@ SmartPTT Server Configuration - C\Pregram Files (x86)\SmartPTT\Server\RadioService exe.config

mlﬁlg

Settings | Metworks |C1ient List I Rules | Activity | Log I Export/Import Settings I Statisticsl

ﬁ Connect Plus
g NAI Systems
-y Capacity Max Networks
=iy Capacity Max 1
R i Corvoler

B8, MNIS Data Gateway

h- MMIS VRC Gateways
! Talkgroups

L. Securty Settings

g SIP/RTP Intefaces
..... B9 SmartPTT Radioservers

Trunking Controller

Primary controller (IP Address:Port) remotehost: 50015
Redundant controllers
| MName // IP Address:Port

Replace with the IP address and
port of the Presence Server

Capacity Max supports up to four redundant trunking controllers to keep the subscribers online when the primary

controller goes offline. The order of redundancy is defined by the settings in Radio Management.

To configure additional trunking controllers:

1. Make sure that redundant trunking controllers are configured in Radio Management.

SmartPTT PLUS 9.1
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2. In your Capacity Max network select Trunking controller.

e ol
Configuration View » CMSS_config » Capacity Max Systems » TVZSysteml*
Set Categories n
Save Save As Discard Cle
v & configuration: CMSS_config
v T Capacity Max Features General  Authentication  Timers  Capacity Max Sites  Adjacent Sites  Site Anneuncement
@ Capacity Max Systems TVZCapacityMaxSystems-1° £ |
@] Capacity Max Site Selection: CMSSSiteSelection-1 Primary Truriking Controller P 192,021 | =
(] EMSS Metwork: CMSSNetwork-1 X o
Primary Trunking Controller UDP Port | 50000 '8
» Il MNIS
Call Monitor Application 11 | 192025 J
Call Moniter Application 1 UDP Pert | 51112 E
Call Monitor Application 2P | 0.00.0 |
Call Moniter Apglication 2 UDP Pert | 51112 | s
Call Monitor Application 31 | 0.00.0 |
| Monitor Application 3 UDP Port | 51112 | g
Voice Interrupt Support
Telephone Support
182.0.2.1
192.0.2.1

3. Click Add in the Redundant controllers area. A new controller will appear in the table.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService exe.config

ol

Settings | Metworks |C1ient List I Rules | Activity | Log I Export/Import Settings I Statistics|

Trunking Controller

----- B9 SmartPTT Radioservers

-y Connect Plus
g MAl Systems
-y Capacity Max Networks Primary controller (P Address:Port) 152.0.2.1:50015
Bh Capacity Max 1 Redundant controllers
h- Trunking Cortroller — -
B8, MNIS Data Gateway Ii remove & Up Diown
~ ?;ll‘z:f;; Geteways | Mame \ IP Address:Port
Ltgt Secunty Settings
g SIP/RTF Interfaces Click to add a new redundant
controller

4. Change the redundant controller IP address and port according to the settings in Radio Management.

Rename the controller if needed. You should name controllers differently.

SmartPTT PLUS 9.1
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&, MNIS Data Gateway

1:5001%

& Up & Down

-
'@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Metworks |C1ient List I Rules | Activity | Log I Export/Import Settings I Statistics|

LR i .
""" & Cortrol Stations Trunking Controller
-y Connect Plus
g MAI Systems

I}]g Capacity Max Networks Primary controller (P Address:Paort) 192.02.
Eh’ Capacity Max 1 Redundart cortrollers
=] Trunking Controller
[ Add ] [ Remove ]

h MHMIS VRC Gateways

Mame

- Talkgroups
L. Securty Settings Redundant controller 1 remotehost:50015
g SIP/RTP Interfaces

IP Address:Port

----- B9 SmartPTT Radioservers [ Change IP address and p

ort to the
pre-configured ones in the Radio

Management program

5. Add more redundant controllers if needed. Change their IP addresses and ports according to the settings in

Radio Management.

Note: If ports of some controllers will be the same you will see an exclamation marks near them (). You cannot

switch to another menu until you would change the ports.

You can change the order of the redundant controllers in the table. This helps to assign a new active controller in

case when others disconnect from each other.

To

1.

change the order of the controllers in the table:

Select the redundant controller.

2. Click Up or Down to move the redundant controller up and down.

SmartPTT PLUS 9.1
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-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService exe.config Elﬂu
Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics ™

Click to mowve the redundant

Trunking Controller controller up or down
Connect Plus o
MAI Systems ] L 1
E-me Capacity Max Networks Primary controller (P Address:Port) 152.0.2.1:5001
Bi Capacity Max 1 Redundant controllers
h Trunking Cortroller _ |
4 MNIS Data Gateway | Ad || Remove | #lUp || #Down
.r?;ll‘zr:ii Gateways MName IP Address:Port

L5t Securty Settings Redundant controller 1 152.0.2.1:50016

g SIP/RTP Interfaces - 192.02.1:50017

----- B9 SmartPTT Radioservers

Redundant controller 2 152.0.2.1:50018

To delete a redundant trunking controller from the table:
1. In your Capacity Max Network select Trunking Controller.
2. Select the redundant controller.

3. Click Remove in the Redundant controllers area.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config @M
Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics |

Trunking Controller
Connect Plus
MAl Systems
e Capacity Max Networks Primary controller (I Address:Port) 192.0.2.1:50015
E‘h’ Capacity Max 1 Redundant controllers
h Trunking Controller = —
g8, MNIS Data Gateway [ A | Remave ) #U || #Down
h MNIS VRC Gateways -
: Talkgroups Mame \ IP Address:Port
¢ Securty Settings Redundant controller 1 152.0.2.1:50016
g SIP/RTP Interfaces Redundant cortroller 2 132.0.2.1:50017

----- B9 SmartPTT Radioservers

Redundant controller 2

Click to remove the =selected
controller from the table

SmartPTT PLUS 9.1 Installation & Configuration Guide



Capacity Max 49

MNIS Data Gateway

To set up data transfer over Capacity Max network, set up MNIS Data Gateway settings in SmartPTT Radioserver
Configurator and in the MOTOTRBO Network Interface Senvice Configuration Utility.

To set up MNIS Data Gateway settings in SmartPTT Radioserver, click Capacity Max Networks > Capacity
Max > MNIS Data Gateway.

-~ Control Stations MNIS Data Gateway
H Connect Flus
g NAI Systems Socket Type ’Lcu:al Socket vl
-y Capacity Max Networks =
™ g Copociy M 1 Interface [192.168.37.85 |
h‘ Trunking Controller MNIS Control Irterface loopback: 55000
(4 MMIS Data Gateway -
MNIS VRC Gateways MNIS ID 1 .
Talkgroups Location Port 4001 =
Lozt Securty Settings
H’ SIP/RTP Inteffaces TMS Port 4007 =
. SmartPTT Radioservers
= Telemetry Port 4008 =
Redundant MMIS data gateway
Socket Type Remote Socket -
MMIS Control Interface (IP Address:Port) remotehost: 55000
MMIS Relay Address (IP Address:Port) remotehost: 3830
Location Port 4011 =
TMS Port 4017 =
Telemetry Port 4018 =

Note: The Data transmission check box in the Capacity Max window should be selected. Otherwise, the MNIS

Data Gateway parameter will not be shown.

Socket Type: Defines the software interface type to enable communication between processes. Select the Local
Socket value if the MOTOTRBO Network Interface Senice Configuration Utility is installed on the same PC as
SmartPTT Radioserver. Select Remote Socket if MOTOTRBO Network Interface Senice Configuration Utility and
SmartPTT Radioserver are installed on a different PCs. In this case, information exchange between the processes

is supported by the MNIS Data Gateway Relay program.

SmartPTT PLUS 9.1 Installation & Configuration Guide



Capacity Max

50

Interface: MOTOTRBO Network Interface Senvice interface. It should match the interface specified in the “Radio

Management” program (see the MNIS System settings in the MNIS menu of the DataMNIS_Config configuration,

the Gateway Tunnel IP field in the Tunnel Network tab).

Radio Management

]O

Configuration View » DataMNIS_Config » MNIS Systern » MNISSystem-2

Set Categories 1

v E Configuration: DataMNIS_Cenfig
» [l Capacity Max Features
* T MNIS
D MNIS Security: MNISSecurity-2
| (] MINIS System: MNISSystem-2 £ |
D MNIS Advanced: MNISAdvanced-2
D MNIS Network: MNISNetwork-2
D MMIS Forwarding Rules: MMISForwardingR

D MNIS Application Override Rules: MNISApg
D MNIS Sites: MMISSitesList-2

Close

General  Tunnel Network

Enhanced Data Enabled ||

Active Voice Talkpath Limit | 0 3

Data Gateway Queue Size |25 g
TX Privacy Type | Mone -

TX Privacy Alias  None

~ ) Tunnel Network

4 >

Connected To:LOCALHOST

Gateway IP 192168101

| Gateway Tunnel i 192168102 |

Analyze Resu|15| |Tasl(5| |Va|idation Results RUETHTL B LB T=lul Search Results |Help

L]

Radio Countl
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MNIS Control Interface: Use localhost, if MOTOTRBO Network Interface Senice Configuration Utility is installed
on the same PC as the radioserver. If MOTOTRBO Network Interface Senice Configuration Utility and the
radioserver are installed on different PCs, enter the IP address of the PC where MOTOTRBO Network Interface
Senice Configuration Utility is installed. The port should match the port number specified in the Radio
Management application (see the MNIS Network settings in the MNIS menu of the DataMNIS_Config

configuration, the Control Interface TCP Port field in the General tab).

Radio kManagement

k3

Configuration View » DataMMIS_Config » MNIS Network » MMNISNetwork-2*

Set Categories a
Save Discard
v E Configuration: DataMNIS_Config
» Capacity Max Features Close
v T MNES General
D MNMIS Security: MNISSecurity-2
(7] MNIS Systern: MNISSystern-2 Telemetry UDP Port | 4008 | E “
[| MMIS Advanced: MNISAdvanced-2 Location Server UDP Port |4D'Dl | g
[ (] MNIS Network: MNISNetwork-2* & | —
User Defined UDP Port 1 |0 - Disabled | o
D MMIS Forwarding Rules: MNISForwardingR —
o ) User Defined UDP Port 2 |0 - Disabled | 3
[| MNIS Application Owverride Rules: MNISApE e — b
(] MNIS Sites: MNISSitesList-2 User Defined UDP Port 3 |0 - Disabled |

KCMP High Efficiency Data Enable | |
ANCMP Server UDF Port 4004

Battery Management UDP Port |4[}09

EIIIH

Control Interface TCP Part | 55000

4 >
Analyze R.esul13| |Tas|r5| |Validation Results REETG TS RO 1210 W0 Search Results |Help
Connected To:LOCALHOST Radic Countl

Note: To open the MNIS menu of the DataMNIS_Config configuration in the Radio Management application,
click Actions > Manage > Configurations or press Alt+C together. In the table that opened, select the
DataMNIS_Config item and click Edit. In the Set Categories tab that opened, click Configuration:
DataMNIS_Config > MNIS.
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MNIS ID: The Common Air Interface (CAl) ID of the MNIS in the radio network. The ID is used by other calling

radios when addressing MOTOTRBO Network Interface Service. Make sure MNIS ID matches the corresponding

field in the Radio Management application (see the MNIS System settings in the MNIS menu of the

DataMNIS_Config configuration, the Data Gateway Radio ID field in the General tab).

Radio Management

L

Configuration View * DataMNIS_Config » MNIS System » MNISSystem-2*

Set Categories 0
Save
v E Configuration: DataMNIS_Config
» Ml Capacity Max Features Close
v T NS General

] MNIS Security: MNISSecurity-2
[ (] S System: MNISsystern-2* £ |
{] MNIS Advanced: MNISAdvanced-2
El MNIS Network: MNISNetwork-2
{7] MNIS Forwarding Rules: MMNISForwardingR
{7] MNIS Application Override Rules: MNISApE

~) General

SetName | MNISSystem-2
Last Modified Date  03/01/2016 14:53:02

Comments |

= R~

Lo

Discard

Tunnel Metwork

{7] MNIS Sites: MNISSitesList-2

IData Gateway Radio ID ‘ 301

4 »

Analyze Results| | Tasks| |Validation Results Wamil\g LUEEEL iGN Search Results | Help

Connected To:LOCALHOST

MMNIS Gateway UDP Port | 50000
Transmission TOT (sec) ‘ a0

Enhanced Data Enabled [

Radio Count:1

Radio Management

L

Location Port: The port where the radioserver

will expect GPS data.

Configuration View * DataMNIS_Config * MNIS Network ¥ MNISNetwork-2

[E=8EoR )

TMS Port: The port where the radioserver will

Set Categaries

» Ml Capacity Max Features
v T MNIS

expect text messages.

Telemetry Port: The port where the radioserver

v = configuration: DataMNIS_Config

(7] MNIS Security: MMNISSecurity-2
(] MNIS System: MNISSystem-2
(7] MNIS Advanced: MNISAdvanced-2

a

Close

General

~) General

[ {7 MnIs Network: MNIsNetwork-2 ¢ |

CAI Network | 12

will expect telemetry data.
The ports should match the ports set in the
corresponding fields in the Radio Management

application (see the MNIS Network settings in

{] MNIS Forwarding Rules: MNISForwardingR
(7] MNIS Application Qverride Rules: MNISApg
(7] MNIS Sites: MNISSitesList-2

CAI Group Network | 225

TMS UDP Port | 4007
Telemeiry UDP Port | 4008

Location Server UDP Port | 4001

User Defined UDP Port 1 |0 - Disabled

User Defined UDF Port 2 |0 - Disabled

3

Connected To:LOCALHOST

the MNIS menu of the DataMNIS_Config

Analyze Results‘ Tasks |Validaﬁnn Results LT RNESL i b | Search Results |Help

Radio Countl

configuration, the Location Server UDP Port

field, the TMS UDP Port field, the Telemetry UDP Port field in the General tab).
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To set up MNIS Data Gateway settings in MOTOTRBO Network Interface Service Configuration Utility, do the
following:
1. Save MNIS Data Gateway settings from the Radio Management application as GWCFGXfile. For that, click
Radios, right click the DATA MNIS... item in the table that opened and click Export > GWCFGX... or press

Ctrl+Shift+N together. In the Export GWCFGX window that opened, specify the file name and click OK.

Radio Management
Radio View
Groups 1
_ Show Details.. Edit Configuration... Analyze
707 g
Serial Number Radio Alias Configuration Group Modified Job Status
> DATAMNISOI St Pl BT P n
S71TRREETE Sholbela =y CUESY mEmmomoEm Completed A
478IRU1223 Belele Bl = mom o om Completed R
A7SIRUIZIF Select Group... Ctrl+Alt+G = momomm Completed R
USESIIPLYA = mmm = pmpleted A
STITNVISIS Edit Canfiguration... Ctrl+F mmomom W Completed A
S07TOHIZ1E Select Configuration... Alt+Shift+F = momomow Completed R
S71TRREA02 = mommw (pmpleted
Select IP System Settings...
47EIRCO01E : - = m om m = Completed
Schedule Job.. Ctrl+)J
Cancel Job Alt+5Shift+]
Select MVO... Alt+Shift+V
Analyze Alt+Shift+5
Reports
1 I 4
Upgrade Firmware...
4 items found (1 . K
Export 3 Radio... Ctrl+Shift+R
Analyze Results | |Tasks Grid to File... Ctrl+Shift+S
Connected ToL OCALHOST EWERGH B
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2. Transfer the saved GWCFGXfile to your PC where the MOTOTRBO Network Interface Senice Configuration

Utility is installed, to the Config folder that is located on the local disk C:/ProgramData/Motorola/Wireline

Gateway.

@o‘-| !/ » Computer » Local Disk (C) » ProgramData » Motorola » Wireline Gateway » Config v|¢,|| Search Pro... }3|

=~ 0 @

Organize » Include in library » Share with + New folder

- Eicin Name Date modified Type Size
- Favorites

Bl Desktop || CapacityMax.gwcfgx 08.02.2016 12:37 WCFGX File 3 Kb
28.04.201417:11 XML Docurment 3 KB

@y

& Downloads =] gw_default_tuning.xml
=] gw_indexxml 14122015 16:47 AML Document 1Kb

2| Recent Places =
- Libraries
@ Documents

J‘ Music

[&5] Pictures

E Videos

18 Computer
£, Local Disk ()

G‘j Network

, 6 items

SmartPTT PLUS 9.1 Installation & Configuration Guide



Capacity Max 55

3. Launch MOTOTRBO Network Interface Senice Configuration Utility and click Configuration > Select
Active Configuration. In the Select Configuration window that opened, select the GWCFGX file saved

before and click OK.

{ MOTOTRBO Network Interface Service Configuration Utility | = | & | %8|

Configuration  View  Edit  Service Help

i O e

Select Configuration

CapacityMagwcigx

If MOTOTRBO Network Interface Senvice and the SmartPTT Radioserver are running on different computers, or you
configure several MNIS Data Gateways, perform the following actions:
1. Install and run MNIS Data Gateway Relay on the computer where MOTOTRBO Network Interface Senvice is
running.

2. Run the MNIS Data Gateway Relay Configurator.

”
@ MMIS Data Gateway Settings —l

MMIS Data Gateway |

MNIS inteface: 192022 -|

Server interface: [152.1].2.2 v] Port: |B830 =)

3. In the MNIS interface field enter the same address as it is in the Tunnel IP Address of MOTOTRBO
Network Interface Senvice Configuration Utility.
4. In the Server interface field enter the same address as you did in the previous step.

5. In the Port type the available port of the computer.
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. Sawe changes and restart MNIS Data Gateway Relay.

6

7. In SmartPTT Radioserver Configurator double-click your network and click MNIS Data Gateway.

8. Inthe Socket Type field select Remote Socket.

9. In the MNIS Control Interface field type IP address of the computer where MOTOTRBO Network Interface
Senice senice is running and the port from the MNIS Control Interface TCP Port field of MOTOTRBO
Network Interface Senice Configuration Utility.

10. In the MNIS Relay Address field type IP address of the computer where MNIS Data Gateway Relay senice

is running and the port from the Port field of MNIS Data Gateway Relay Configurator.

MHNIS Data Gateway

Socket Type Remote Soclet v]
MMIS Control Interface 203.0.113.1:55000
MMIS Relay Address 203.0.113.1:8850

MMNIS 1D 1 MNIS Control Interface TCP Port
- (MNIS Configuration Utility)

Location Paort 4001 =

TMS Port 4007 =
- Server port

Telemetry Port 4008 e {MNIS Data Gateway Relay)

11. Configure other settings as describer previously.

12. Save changes and restart radioserver.

MNIS VRC Gateway

Every Capacity Max network supports up to 15 MNIS VRC gateways. The first gateway is created always exists
in the network, so you can add 14 gateways more.

The order of the gateways matters a lot. All newly created profiles and talkgroups for your Capacity Max network
will be assigned for the first MNIS VRC Gateway in the list. Therefore, you should be careful when configure

several MNIS VRC Gateways.

To configure MNIS VRC gateway:

SmartPTT PLUS 9.1 Installation & Configuration Guide



Capacity Max

57

1. Make sure that VRC Gateway is configured in the “Radio Management” program. For more information

please refer to Radio Management User Guide.

Radio Management

&

Configuration View » Primary_CMSS_config » CMSS Network » Network-L1

Set Categories ]

v 5 Configuration: Primary_CMSS_config
v U Capacity Max Features
Capacity Max Systems: CapacityMaxSystem

Close

[ei] Capacity Max Site Selection: CapacityMaxS,

[E=8 =R

iy

[ Radio Management

By

Configuration View » Primary_CMSS_config » MNIS Network » MNISNetwork-1*

Set Categories 1
Save
v 5 configuration: Primary_CMSS_config

v T Capacity Max Features
(% Capacity Max Systems: CapacityMaxSystem

Close

General
(% Capacity Max Site Selection: CapacityMax3;

[Anclyze Results| [Tasks| [Validation Results [ L e tig] Scarch Results  Help

»

~ General B (7] CMISS Network: Networke1
» I MNIS —— ~ T MNIS
cMssip [1721810 | (] MANIS Systerm: MNISSystem-1
CMSS UDP Port | 50000 s

Trunking Controller 1P 172.16.1.10:50000

Presence Server [P 17216.1.10:50015

VAC Gateway [P 172.16.1.13

System Advisorip 17216114

CMSS Internal Network | 1821682310

~) General

General

Set Name | MNISNetwork-1 |
Last Modified Date  03/01/2016 11:5745

Comments |

[E=8E=R 5

Discard

«

[Analyze Results|  [Tasks|  |Validation Results [t LR RO Search Results| Help

»

| Connected TaiL OCALHOST

Radio Countl | | Connected To:.OCALHOST

Server TCP Port | 6000 a

Radio Count:1

2. In your Capacity Max network select Voice Transmission to show and allow to configure

MNIS VRC Gateways.

.
ﬁ SmartPTT Server Configuration - C\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config

:Elg

Settings | Metworks |Cliant List I Rules I Activity I Log I Export/Import Settings I Statisticsl

H’ Connect Plus

H MAI Systems
[—jH’ Capacity Max Networks

Elh- Capacity Mz 1
- Trunking Controller

-E8 MNIS Data Gateway
h MMNIS VRC Gateways
Talkgroups

Letgt Securty Settings
H SIP/RTP Interfaces
----- B9 SmartPTT Radioservers

Capacity Max System
Active

Mame: Capacity Max 1

Metwar [D: 1

Radio 1D: 1

Interface: 192.0.2.1 -

Presence information

Data transmission

Allow transmit intemupt
Prioritize calls during emengency
Channel Grant Waiting timer (s):

TX time-out timer (s):

GPS transmission mode: [D’ata

3. To add a new MNIS VRC Gateway right-click MNIS VRC Gateway and click Add.
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-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService exe.config

:.IEIQ

Settings | Metworks |C1ient List I Rules | Activity | Log I Export/Import Settings I Statistics|

----- t, - Control Stations

-4y Connect Plus

g NAI Systems

[_]..ﬁ Capacity Max Networks

= h- Capacity Max 1
..... h- Trunking Cantroller
...... - MNIS Data Gateway

MHIS VRC Gateways

i g
Talkgroups |_

Add

T Security Settings
-y SIP/RTF Interfaces

----- B SmartPTT Radioservers

4. Select the newly created or exi

sting gateway.

Note: By default, all new gateways obtain equal IP addresses and ports. When you select one of those, you will

not be able to leave the meny until you make its IP address and port unique within the site.

5. Configure the gateway options.

----- % Control Stations

iy Connect Plus

g NAI Systems

- Capacity Max Networks

B- i Capacity Max 1
..... h Trunking Cortroller
...... -l MNIS Data Gateway
E| h MMIS VRC Gateways

Talkagroups
L. Securty Seftings
-4y SIP/RTP Interfaces
----- BN SmartPTT Radioservers

P MNIS VRC Gateway 1

MHIS VRC Gateway

Mame

Primary gateway address and port

Redundant gateway address and
port

Yoice port (ocal)

MMIS VRC Gateway 1

remotehost 56000

40000

=

Recarding of voice calls between radio subscribers

Example: 1-55, 150
Radio IDs for voice calls recording 4 qe-7p415
Telephone calls
Example: 1-55, 150
Radio |Ds for phone calls 116776415
Talk paths (1)
@ Private (1) ) Group (0)
Active MName D

Default radio 1D

o Name: The name of the gateway in SmartPTT Radioserver Configurator. Rename your gateway if needed.

¢ Primary gateway address and port: IP address from VRC Gateway IP and port from Server TCP port

which were configured in your CMSS Network in Radio Management.
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o Redundant gateway address and port: IP address of VRC Gateway IP and port from Server TPC port
of the additional CMS server you assign to be redundant. You can leave this field empty if you do not have
redundant VRC gateway.

e Voice port (local): The port at which SmartPTT Radioserver will expect the wice data.

o Recording of voice calls between subscribers: Select this to activate wice recording feature, that
allows the dispatcher to hear private calls made from radio subscribers to other radio subscribers,
dispatchers or telephone subscribers.

o Radio IDs for voice call recording: Enter radio IDs for which the recording should be active.
Follow the example, to specify the IDs.

e Phone calls: Select this if you want to allow telephone calls for this gateway.

o Radio IDs for phone calls: Enter radio IDs for which phone calls should be available. Follow the
examples, to specify the IDs.

e Talk paths: You can reorganize the default gateway for radios and profiles here.

o Private: Select this to view the subscriber profiles which assigned to the current gateway. Profiles
can be assigned to the gateway (Active is selected), not assigned (Active is unselected) and
unavailable on it (Active is unselected, profile name is discolored). If the profile is unavailable, it
means that it is selected on the other gateway. By default all new profiles will be selected on the

first gateway in the list and their ID will be the same as that of the first gateway in the list.
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o Group: Select this to view talkgroups created for the current site. For more information see

Talkgroups in the Capacity Max chapter.
Talk paths (5)
Private (2) ) Group (3)

SmartPTT PLUS 9.1

Active MName D
Default radio 1D, Profile 1, Profile 4 | 1
Profile 2, Profile 5, Profile 9, Profil... |2
Profile 3, Profile 6, Profile 7, Profil... |3

Talk paths (5)

™) Private (2) Group (3)

Mame ]

Group 2

2

Group 3

3
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Talkgroups
To configure Capacity Max talkgroups, click Talkgroups. At that the following window opens.
""" - Cortral Stations Control Station Talkgroups
H Connect Plus
iy MNAI Systems [ T ] ’ Paste ]
[—}-ﬁ Capacity Max Metworks
Bh Capacity Max 1
h Trunking Corntroller [ All Call ]
-8, MNIS Data Gateway -
h MNIS VRC Gateways [ Add “ Remowve ] [ i Up ” # Down ]
MName ID Site Number Voice gateway
L.tk Securty Settings )
H’ SIP/RTF Irterfaces Al Call - Site 1 1 * |MMNIS VBC Gateway 1 |~
----- FN SmatPTT Radioservers Group 1 Wide ~ |MNIS VRC Gateway 2 |~
Group 2 2 Wide * | MMIS VRC Gateway 2 |~

To add a talkgroup, click Add. To add an All Call, click All Call. The added talkgroups will also appear in the

Profiles window. To change the order of groups in the list, use the Up and Down arrows. The order defined in the

window will be used in SmartPTT Dispatcher. To copy added groups to the clipboard, click Copy. To paste copied

groups from the clipboard, click Paste. To delete the selected talkgroup, click Remove.

Name: Talkgroup alias displayed by the control station.

ID: Talkgroup unique identifier used during communications. It should be set in the range of 7-65535 for a

talkgroup, and in the ranges of 1-16776415, 16777056—-16777183 or should be equal to 16777214 for an All Call.

To edit the talkgroup name or ID, set the cursor on the corresponding field and make changes.

Site Number: Site number list allowed for transmitting. In the Capacity Max network the talkgroups can be only

wide-area, while All Call can be wide-area or local.

Note: In the Capacity Max network you can add only wide-area talkgroups, so only the Wide value is

available for groups in the Site Number field. In order to display wide area talkgroups in SmartPTT

Dispatcher, add necessary talkgroups in SmartPTT Radioserver Configurator, define talkgroup identifiers that

correspond to the identifiers of the wide-area talkgroups in the Radio Management settings. You can add a

wide-area All Call and a local All Call, which is limited to one site. To add a wide-area All Call, which is

available to all sites, click All Call. Make sure that Site Number is set to Wide. To add an All Call limited to

one site, click All Call, and in the Site Number field select the site number where the All Call will be heard.

Please note, that you do not need any IDs for All Calls.

Voice gateway: List of available wice gateways. You can assign a certain wice gateway for each talkgroup.
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Note: If there are some available wice gateways, all talkgroups will use by default the first voice gateway in
the list. If the talkgroup is not registered on any wice gateway, the Voice gateway field will be empty. If
Voice transmission is not selected in the Capacity Max network settings, the Voice gateway column will

be hidden.

You should create talkgroups in accordance with the settings in the Radio Management program (see the
Capacity Max Systems settings, sorted by the Talkgroup Site Association value). For more detailed

information, please refer to the Motorola Radio Management User Guide.

Settings | Networks | Client List | Rules | Activty | Log | Expornt/impont Settings | Statistes | [ Radio = o
- Control Stations Control Station Talkgroups
. fagf Connect Plus
g NAI Systems = =
(=4 Capacity Max Networks [ By ] [ = ]
| - iy Capachy Max 1
H Jug Trunking Cortroller Alcal Capacity Max System Server Data ¥ Talkgroup Site As...
: B, MNIS Data Gateway
-t MNIS VRC Gateways [ ad ][ Remore ] [ @Up [ #Down ] Capacity Max Systems [ ) , _
v Viewby: (] Subscriber Access Control () Talkgroup Site Association
e eway Name D Ste Number___ Voice gateway - —_—
-y MNIS VRC Gateway 2 OurSysteml
g MNIS VAC Gatewy 3 Acal Wide = | MNiS VAC Gateway 1 [+ | g
Al Cal - Ste 1 1 | MNIS VAC Gateway 1 |~ I
; T Securty Settings
e SIP/RTP Interfaces Al Cal - Sie 2 2 ~ | MNIS VRC Gateway 1 |~ TalkgrouplD ~ Queue Priority | Allowed Stes E
B SmarPTT Radioservers Group 106 106 Viide ~ | MNIS VRC Gateway 2 |~ 106 6 ~ Site Selection 1 o |
Group 107 07 |wide ~ | MNIS VAC Gateway 2 |~ w6 + | Site Selection 1 .
Group 108 08 |wide | mnis vRC Gateway 2 |+
108 6 - Site Selection 1 -
Group 109 09 |wide = | mnis vAC Geteway 2 [ =
Group 110 10 Wiide = [ mnis VAC Gateway 2 |+ B 6 ~ SR T
Group 111 1 Wide = | MNIS VRC Gateway 3 | ~ 0 6 ™ Site Selection 1 M
Group 112 12 |wide = | MNiS VAC Gateway 3 [ = m 6 ~ Site Selection 1 -
Group 113 13 |wide ~ | MNIS VAC Gateway 3 |~ 12 6 «  Site Selection 1 -
Group 114 114 |wide ~ | MNis VAC Gateway 3 | » n3ls | Site Selection 1 .
14 5 ~ Site Selection 1 ~ [
102 items found (0 currently selected).
Analyze Results| |Tasks
Connected Tol GCALHOST

Note: To open the Capacity Max System settings in the Radio Management program, click Actions > Manage

> Capacity Max System Server Data.

Security Settings in Capacity Max

Capacity Max network supports two types of privacy mechanisms — Enhanced and Advanced Encryption
Standard (AES). The Enhanced Privacy utilizes Motorola proprietary algorithms and therefore is not interoperable
with other vendor's privacy offerings. The Enhanced Privacy provides high level of protection by means of 40-bit key
length and supports multiple keys in a radio. The Advanced Encryption Standard (AES) is a specification for the
encryption of electronic data established by the U.S. National Institute of Standards and Technology (NIST). The
AES feature supports 256-bit key length, unlike Enhanced Privacy. Similar to Enhanced Privacy, the AES also

supports multiple keys. For AES encryption a special license is required.
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The Security Settings window allows you to specify the encryption keys for incoming and outgoing traffic on the

digital channel.

E grrtr:'lcft;:tinns Security Settings
nn s
g MAI Systems [ Copy ] Paste
E-g Capacity Max Networks
=g Capacity Max 1 Enhanced Privacy
h Trunking Contraller
g MNIS Data Gateway ) [Chenmews |
=i MNIS VRC Gateways D Val
h- MNIS VRC Gateway 1 e Koy Voo
------ Talkgroups
.
g SIP/RTP Intedfaces
----- FN SmartPTT Radioservers
AES
[ Add ] [ Remove ]
Key 1D Key Value
T Privacy
Type |MNo "] Key ID

Copy: Copy encryption settings of the channel to the clipboard.

Paste: Paste encryption settings of the channel from the clipboard.
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Enhanced Privacy
To configure Enhanced Privacy, perform the following actions:
1. In the Security Settings window of SmartPTT Radioserver Configurator add an enhanced privacy key for

incoming traffic. Enter its ID and value in the corresponding fields.

Click to remowve the
zelected enhanced

privacy key

Click to add the
enhanced privacy
ey

Enhanced Privacy

-H\-\[\ Add H Hemu'u'e‘T/

Key (D Key Value
1 0123456785

Note: Key ID and Key Value must match the values set in the radio settings in the Radio Management
program and MOTOTRBO Network Interface Service Configuration Utility. If the values in the Key ID fields
are the same, but the values in the Key Value fields do not match, the receiving side hears only a distorted
woice. If the key identifier of the transmitting side does not coincide with one of the key identifiers in the list of

the receiving side, then transfer to the receiving party will not be heard.
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2. Inthe Privacy Keys tab of the Radio Management program add the enhanced privacy key. Enter its ID and

value in the corresponding fields (see the Note abowe).

Radio Management E’E
Click to add the
Resource View » Privacy Keys enhanced
privacy key
Resources a

Firmware

Language Packs KeyID | KeyAlias  KeyValue | In-Use Templates and Sets

Voice Announcements 1 Privl 0123456789 1 o]

Text To Speech Packs
Symmetric Keys
RAS Keys

Privacy Keys
OTAP Keys

4 —— 4

Litems found (0 currently selected).

Analyze Results| |Compare Results| |[E s tg)
Connected To:LOCALHOST
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Then open the configuration of the required radio station and in the Set Categories menu click General >
Security. To make the added enhanced privacy keys available for selection, add them in the selection set.

To do that, in the Privacy field click the Add button.

Radio Managerment EI@

o]0 ©

Configuration View » 80TTQH1216 » Security » Security-101

Set Categories q
Close

- E Configuration: 807TQH1216
v Tl General General Privacy ~ AES  OTAR  Restricted Access to System Ower-the-Air Programming
|‘:| Welcome Bitmap

D Language Packs: PCRLanguag ) Privacy B

Privacy Type | Enhanced - I

Basic Privacy Key 0 - (Blank)

D General Settings: GenaralSetti
|‘:| Accessories: Accessories-101

|‘:| Control Buttons: ControlButte

D Text Messages: TextMessages Enhanced Privacy Keys
D Telemetry: Telemetry-101
|‘:| Menu: Menu-101

I[ |‘:| Security: Security-101 £ " i y Key Alias Key Value
D Metwork: Network-101

@ Voice Announcement: Voiced Click to add the enhanced

|‘:| Indoor Location: IndoarLocati privacy key in the selection set

4 I »

Analyze Resu|15| |Compare Resu Ils| IEECEY | Validation Results RUETHTGELNEEERL =10 W) Search Results | Help
Connected To:LOCALHOST Radio Countl
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At that the Add Keys window will open. Select the required keys, which you want to be available for selection in

the Privacy Alias field when specifying the enhanced key on the channel and click OK.

]
w (]2

E Add Keys E

Key ID Key Alias Key Value = Comments

Privl

1 items found (1 currently selectad).

[ ¢

0123456789

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

= fil) DR 3000

M- Channels

SmartPTT PLUS 9.1

Top Brivacy

IPTWW Type IEnhanoed 'Il
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4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Enhanced field

add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note abowe).

= 4 Untitled
General Click to add the Click to remove the
-- enhancf:d privacy seleu:.'t_ed entanced
- =8 Group List = Ao Al
- &8 Conventional Add ] [ Delete
- & Capacity Plus
il <% Linked Capacy Plus Alias KeylD  Key Value
& Advanced | Enhanced Key E 0123456789 |

5. In the radio settings in the Radio Management program to enable the encryption mode on the required

channel select the Privacy checkbox and in the Privacy Alias field select the enhanced privacy key for this

121 Radio Management ol ===
Configuration View » B0TTQH1216 » Zone » Zonel®
Set Categories 1
Save Discard Close
v [ Configuration: 807TQH1216 E
> [l General
» [l Job Tickets a’ T=1T.,T+1 "
> Il Mandown i el el B
> Il Systems = Position Set Name: Channel Type ChannelName | Voice Announ:  Phone System  Privacy Privacy Alias AES Alias
g : Encoder Ws: 1 Personality-101  Capacity Max Personsli TG101Channel  None PhoneSystems1 Privl, None
> Decoder :
s: 2 Personality-164  Capacity Max Personality TG102Channel  None PhoneSvstems] Priv MNone
» [l Contacts
» Il RX Group Lists s: 3 Personality-163  Capacity Max Personsiity TG103Channel  None Select to enable Privl | Select the enhanced
P ) the privacy privacy key
» [l Capacity Max Features e 4 Personality-162  Capacity Max Personality TGL04Channel  None Priv
v By Zone/Channel Assignment LK S Personality-161  Capacity Max Personsiity Enhanced None PhoneSystems1 Privl None
v ([ Zoner L3 6 Personality-160  Capacity Max Personality SiteAlICall None PhoneSystems1 Privl Mone
el ) ifs: 7 Personality-159  Capacity Max Personality MultiSiteAllCall  None PhoneSystems1 Priv Nane
® Channel Pool ) )
Ws: 8 Personality-158  Capacity Max Personality TG63536 None PhoneSystems1 Privl Nane -
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AES Privacy

To configure the AES privacy, perform the following actions:

69

1. In the Security Settings window of SmartPTT Radioserver Configurator add an AES privacy key for incoming

traffic. Enter its ID and value in the corresponding fields.

Click to add the
AES privacy key

ﬁrﬁdd ] [ Remove

Click to remowe the
selected AES privacy key

Key ID

Key Value

1

59876543210

Note: Key ID and Key Value must match the values set in the radio settings in the Radio Management

program and in MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields

are the same, but the values in the Key Value fields do not match, the receiving side hears only a distorted

woice. If the key identifier of the transmitting side does not coincide with one of the key identifiers in the list of

the receiving side, then transfer to the receiving party will not be heard.
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2. In the Symmetric Keys tab of the Radio Management program add the AES privacy key. Enter its ID and

value in the corresponding fields (see the Note abowe).

Radio Management E’E

2 JO

Resource View P Symmetric Keys

Resources q
Firmware
Language Packs KeyID | KeyAlias  KeyValue | In-Use Templates and Sets
Woice Announcements 1 Syml 9876543210 1 0

Text To Speech Packs

Symmetric Keys
RAS Keys

Privacy Keys
OTAP Keys

4 —— »

1 items found (0 currently selected).

Analyze Results| |Compare Results| i citag)
Connected To:LOCALHOST
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Then open the configuration of the required radio station and in the Set Categories menu click General >
Security. To make the added AES privacy keys available for selection, add them in the selection set. To do

that, in the AES field click the Add button.

Radio Management

o]0 ©

Configuration View ® B0TTQH1216 » Security ® Security-101

Set Categories 1

Close

A E Configuration: 807TQH1216
v Tl General General Privacy  AES  OTAR  Restricted Access to System
(] Weicome Bitmap

[l Language Packs: PCRLanguag

Ower-the-Air Programming

El General Settings: GeneralSetti ~1 AES P
El Accessones: Accessories-101

[l Control Buttons: ControlButtc

[:l Text Messages: TextMessages _-I*- HDD I

[:l Telemetry: Telemetry-101
Il:l Menu: Menu-101 ) Key Alias Key Value

I[ [] Security: Security-101  {i# ]I
[] Metwork: Metwork-101 ‘

Click to add the AES provicy
key in the selection set

El Voice Announcement: Voiced

El Indoor Location: IndoorLocati
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At that the Add Keys window will open. Select the required keys, which you want to be available for selection in

the AES Alias field when specifying the AES privacy key on the channel and click OK.

[]
]2

E Add Keys E

Key IDr Key Alias key Value
Syml 9876543210

1 items found (1 currently selected).

[ ¢

Comments

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

= fil) DR 3000

M- Channels

SmartPTT PLUS 9.1

Top Brivacy

IPTWW Type IEnhanoed 'Il
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4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Symmetric
Keys field add the AES symmetric privacy key. Enter its ID and value in the corresponding fields (see the

Note abowe)

= @ Untitled

) General Click to add the AES Click to remowve the
privacy key selected EES privacy
B Group List =i/

B 2 Con\rl:;ntional g ] [ LEE ’j_/—

- &b Capacity Plus
i#} <@ Lirksd Capacty Plus Alas KeylD  Key Value

@ Advanced J | Symmetric Key1 E 9676543210 |

5. In the radio settings in the Radio Management program to enable the AES encryption mode on the required

channel unselect the Privacy checkbox and in the AES Alias field select the AES privacy key.

[Z] Radio Management o e =]
Configuration View ¥ BOTTQH1216 * Zone P Zonel®
Set Categories 1
Save Discard Close
v [ configuration: 807TQH1216 2

» Ml General
» [l Job Tickets u’ L A6 Jdi 4 B
» Il Mandown + R Sl Bl
» Il Systems = Set Name Channel Type Channel Name | Voice Announ: | Phone System | Privacy Privacy Alias | AES Alias
> [ Encoder s 1 Personality-101  Capacity Max Personality TG101Channel  None PhoneSystemsl Q Mane syml
» [l Decoder

- [E3 2 Personality-164  Capacity Max Personality TG102Channel  None PhoneSystems1 MNone ne
» [l Contacts = =

. iy~ Unselect the Priva Select the AES

» Il RX Group Lists LB 3 Personality-163  Capacity Max Personality TG103Channel  None PhoneSystems{ Unsslect the Privacy’)  an D
» [ Capacity Max Features & 4 Personality-162  Capacity Max Personality TG104Channel  Nane P m: Nen
v T Zone/Channel Assignment i 5 Personality-161  Capacity Max Personality Enhanced None PhoneSystems1 ] Mane None

v [ Zener LB 6 Personality-160  Capacity Max Personality SiteAllCall None PhoneSystemsl ] Nene None

@ Zonel {3 4 7 Personality-159  Capacity Max Personality MultiSiteAllCall  None PhoneSystems1 O Mone None
Chy | Pool .
® Channel Pao e 8 Personality-158  Capacity Max Peronsiity TGE5526 None PhoneSystemsl. ] None None B

TX Privacy

TX Privacy

Type iNﬂ v] Key (D
|

Enhanced
AES (Symmetric Key)

Type: Allows you to select encryption mode for outgoing traffic on the side of SmartPTT Dispatcher.
If No is set, radioserver does not support outbound traffic encryption.
If Enhanced is set, specify the Key ID value from the Enhanced Privacy table, which will be used to encrypt

outbound traffic.
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Select AES (Symmetric Key), with the required Key ID, if you want to use AES (Symmetric Key) for outgoing
traffic. If TX Privacy is not set, and you have AES encryption for incoming traffic, AES (Symmetric Key) will be

used for incoming traffic by default.

AES (Symmetric Key) — AES encryption (DMR-compliant implementation, MOTOTRBO firmware R2.4 and later).
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